Name of the Course : B.Com. (Hons.) CBCS
N;mt' of the Paper : Computer Applications In Business
Altempt All questions,

PART A
Q. 1. State True or False. Give reason:
| (1) ATMs are Computers,

(b) Translators are not required for “High Level languages”.
(c) Computers using Decimal numbers are faster,
(d) DBMS stores variety of data related to an accounting system.
() Page orientation cannot be changed in MS-Word.
Ans. (a) False. ATMs (automated teller machine)
cation devices that enable

5x2=10

are electronic telecommuni-

the customers of a financial institution to

perform financial transactions, particularly cash withdrawals, without
the need for 2 human cashier, clerk or bank teller.

(b) False. Translators are required to convert a program written in a high
level language into machine language.

(c) False. Computers using binary number system are faster.

(d) True. DBMS stores variety of data related forms,
(e) False.

Word.

Q. 2. (a) What are External Stora
popular.

reports, etc.
Page orientation can be changed to Portrait or Landscape in MS-

ge Devices? Explain any fwo which are ver};
5

(b) What are the difficulties in using audit softwares. 5
Ans. (a) External Storage Devices. External storage comprises devices that
temporarily store information in a computer system. Such devices are not
permanently fixed inside a computer. They are also called auxiliary or secondary
storage devices. They provide backup storage for instructions (software
programs) and data, Most commonly used secondary memory devices are hard
disks, magnetic disks, and magnetic tapes. Secondary storage devices are less
expensive as compared to primary storage devices. However, they have much
larger storage capacity than primary memory. Instructions and data stored on
secondary storage devices are permanent in nature. It can only be removed if the

- user wants it so or the device is destroyed.

(7) Hard disk. A hard disk is a data storage device used for storing and
retrieving digital information using one or more rigid rapidly rotating
disks (platters) coated with magnetic material. The platters are paired
with magnetic heads arranged on a moving actuator arm, which read
and write data to the platter surfaces. Data is accessed in a random-
access rmanner, meaning that individual blocks of data can be stored or
retrieved in any order rather than sequentially. An HDD retains its data
even when powered off.

(i) Optical storage. Optical storage is the media that use laser light
technology for data storage and retrieval.
102
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(b) Difficulties in using Audit Software. See Q. 3, Unit V [Page 57

_ Or
(a) What is software and how it is useful for computer operation?

(b) What are CAA ;
Ans. (a) T tools and their types?

ur W

Software and its uses
1t fprare is . » . :
2 language thzt can be ; ' S:’,' tware is 2 sequence of instructions written in
2 of commeh 1 0e understood by a computer. The term software refers to a
and b l‘; 'CT programs, and associated documents that describe the program
24 ow they are to be ys . e A -
ke s hj-,—-r. hJ : used. To get 2 particular job done by a computer, the
¥ = 5 '8 . - . -
inchides th are should be lozded in the hardware before processing starts. It
- =3 r(Jr amr -% r 1 . - - .

TA(J’.H:‘{ «,nftv,'alrjﬂ rf;'l b‘Jd;ha _ﬁC!sz".‘tr?, :19 processing activity of the computer.
. cT - "'S[ ‘; U"..Q ol A;(' 1 + v
Application software ; ito bwo majar categories: System software and

System Softw .
bl are is 3 set of one or more programs designed to control the
anTalIOn and extend the i bt 2 ;
Bie control and ¢ ¢ processing capability of a computer. It contributes to
the system mo periormance of the computer system and permits the user to use
- Sy B Te Convenieritly. Syste frware & .
. ¥. System software is trensparent a s ;
s typical user. znsparent and less noticed by
System s . . . ;
| /— h:r)ftwan_ comprises programs written in low-level languages, which
interact with the hardware at 2 very basic level. They are the basic necessity of a
computer system for s proper functioning. System software serves as the
interface between hardware and the end users. System software not only controls |
the hardware but also provides a platform for other programs to run on them. 3
All the programs which can be 2 part of System software can be classified
into three categories:
* Operating System ;.
* Programming languages (viz., assembler, translator, interpreter,
compiler, loader and linker).
» Utility Programs.
Application software (also called End User Program) includes User oriented
programs designed and developed for performing specific tasks such as payroll
accounting, financial accounting, etc. It is 2 set of one or more programs designed
te; solve a Sp“.rjflc Pf()bff_-m or do a Sp(:lelC ta_":k_ ] i f " " ;
4 ‘ ' ‘are av : a wide range o
[here are many types of application software available (fr a wide b: i
applications such as inventory management, preparation of tax return, banking,
most common are word-processing

! inistratl ! ance, etc. Some
hospital administration, insurance, etc. | _
software, spread sheel software, database software, graphics software, personal

inment software.
assistance software, ed rtain

ucation software and ente _—

ni age
(h) Sec Q. 1, Unit V. ' . O i
0. 3. (a) What is the difference between copying and moving a :

in MS-Excel? . . L
i | d Mixed cell referencing In
(h) Differentiate between Absolute, Relative an p

Mb-Fxcel with suitable example.

Mg
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'\h\ t.} Loy \7“. | L a user Can use thwe Lt k(‘¥‘} i Jﬂd l-‘.\iL‘ rh‘““\dndc h\
.-3-:7'\‘\._",‘ Wit 8 3_3\..'\‘ 0 MOYe Or Cﬁ?\‘ cntire \‘n‘.IS or themr contents.
When cells are copwed the data i/or fort o . __ .
* When cells are copw ¢ data and/or formulae are rephicated whereac
L By

¢ data, the original data is cut and moved 1o ney
9

Ceis
* When cells are copred. cell references are automatically adiusted. Wh
s 2 - ‘. _ AL 2 i on
cells are moved. cell references are not adjusted, ang the contents of
S QL

those cells and of any cells that point to them may be displaved as
> - B das
reference errors.
* Moving data an

_ xd files whether it is a block of text in vour wo
or a folder on your hard drive, transfer something comple
pomnt to another. Once the move command is used, tl

td processor
tely from one
1€ onginal content 1S

gone from the onginal location. Copving a file, folder or piece of text
means duplicating it. It appears in its new location and Temains in the

old one too.
(b) See Q. 3(0Or)(h), 2014. [Page 93

Or

(@) What is the difference betwecn ‘I rpiace . ind And
Replace’ operation in MS-Word? 5
(b) Explain any three logical functions used in MS-Excel? 5

Ans. (a) Replace and Replace All in MS Word. Find And Replace operation -
automatically replaces a word or phrase with another. For cxanple, a user can
replace s/w with Software. The replacement text uses the same capitalization as
the text that it replaces unless user selects the Match case check box.

Replace option replaces one occurrence of the text al a time whereas Replace
All opton replaces all the occurrences of the text simultaneously.

(b) Logical functions in MS Excel. See Q. 6(a), 2014. [Page 86
Q. 4. (a) How can you insert audio clip in a PowerPoint presentation? 5
(b) Explain the font as formatting features in MS-Excell. 5

Ans. (a) Steps to insert audio clip in PowerPoint Presentation:
1. Click the shde to add an audio clip.
2. On the Insert tab, in the Media group, click Audio.
3. Click Audio from File, locate the folder that contains the file, and then
double-click the file that is to be added. '
(b) Formatting Font in MS Excel.
To change the font or font size in a worksheet:
1. Select the cell, range of cells, text or characters to format.
2. On the Home tab, in the Font group:

(1) Click the required font in the Font box to change the font.

(11) To change the font size, click the required fonl size in the Font Size box,
or click Increase Font Size Button image or Decrease Font Size Button
image until the desired font size is displayed in the Font Size box.

Or
(@) How animation is useful in the context of slide show? 5
(b) What functions are used for regression analysis? Illustrate with syntax.>
Ans. (a) Usefulness of animation in slide show. Animation can help make a
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xltLTn~~lwll ln.\u rl _n_mi Presentation more dynamic. and help make information
mmc\ n_u'njc_wr.;hlt_-. Fhe most common lvpes of ‘mim"“”” offects include entrances
and exits. The user can also add sound to increase the intensity of the animation
cltecls,

R
‘_r:::;hl F:\:::;T;lfl;;l; :\‘::L;‘i\ r.{-\fmnmond 1!~+in;: .mim.llmn‘u and ‘;nu.nd effects
help to emphasize poi 3 useful in making a presentation mr'wru lively, and

(b) Functlions u;g(;):‘l::'r:”' If“.' much .mllmnliun can be distracting.

Excel includes seve & TIman malyxie o |
LINEST, TRFJ\t[; ;g;ur_acl -gr‘a_\ “”:‘:““”f* fﬂf performing linear regression —
LOGEST nnd— GR‘OW‘HJ[ AST, SLOPE and STEYX, and exponential regression

SLO.PE' The SLOPE function returns the slope of the linear r(‘yl:n'qr.inn line. The
slope is defined as the vertical distance divided by the horizontal distance
:::;tgl ‘“C';].\;Eh’f’“ qPOinl,s on the r?grcssion line. The SLOPE function takes the

TREND (f””‘””—f’ s, .knnzm_r_.\'s), | |
given dﬂlea‘.?j]l\ENn?, fLan!‘mn finds points that lie along the regression line for
o Tine. TRFNDn; L'ff-‘rk‘ltlr‘n(‘ti by TREND function can be usud. to plol a
guesses about —fu[urcl_lgc:mn can be used to cxl'rapnlnt.o,‘nr make intelligent
Syntax of TREND functia B basec. on the tendandivs axhibigyg i oy, dst.
y ction =TREND (known_y's, known_x's, new_x’s, const).

i PART B
Q. 5. Give example of any thiree mathematical functions with syntax.
Ans Mathematical Functions:

(/) SUM. Sum function totals a serics of numbers and takes the form
ZSUM(num],numZ ...), where nums (max 30) can be numbers,
formulas, ranges, or cell references. It ignores arguments that refer to
text values, logical values or blank cells. |

(17) SUMIF. Sumif function tests each cell in a range before adding it to the
total. It takes the form =SUMIF(range, criteria, sum_range), where range
is the range lo test; criferia is the logical test to be performed on each cell;
and sum_range specifies the cells to be summed up.

(iii) COUNTIF. Countif function counts only those cells that match the
specified criteria and it takes the form =COUNTIF(range, criteria),
where range is the range to be tested and criteria is the logical test to be

performed on each cell. .
Q. 6. (a) Write syntax of different formula to find Maximum, Minimum, and
5

5

Sum of given numbers.

(b) A person takes the loan on following terms:

e JLoan amount 135,00,000

¢ Rate of Interesl 19.25% pa .

¢ Loan period 4 years (48 instalments, re.,
g Mode of payment-Monthly)

CEL. Also write appropriate formula in

th uired sheet in MS-EX at
Mg{‘g)‘(vCE[?t?gompute the EMI and interest amount for the 45" instalment.10

Ans. (a) Syntax
(i) Maximum: =Max(num1,num2, ...)

Scanned by CamScanner



-—

- - o ¥
Ans_ ( ¢ Eecel. 2 user can use the Cu 2
£ B - o
‘ - a’ i TN OF e eritiTe C2LlS OT theiT CCO 2T
f1—- ¥iyre ExcE e copy entire
*iiC "'ﬁ-"'l RO LA : i B i
) - el e dz2tz and /or loTIUGI2E aTE MEPlIc3 0O Wihwreas
e When Ooiis &€ LSpRis i e g
P e i - - 1 i = -k = - .
: e e datz the ongnal G2z 12 CUl 2and MOoYved ID nNew
s o OF D¥0Y B £ O Gate, ST _
in case
S - shagas i .
- =2 _ . e cell references are automa@OCally adjusied. Ve nen
™ 'i'- e OPlls 2 QOPRCO. L 3Rl )
2 o C - .= P ot thh RO
. . mmred il referenices are not adtusied, and the contents of
e ¢ 3IE e, WL = -
e = 3 r c Emad pmee—b 3 . 3% 'C“ Az fa, {_d as
e 't-.—z ;"‘: o E:--s' CERES A prsasta AJ Lalimasd I. ’ = i ‘p_ ‘v 7
P . sl —_— - g 4
refeTenos €TTorS
: - - p— % 2r = blarl of Bosw® w53 TIRIE W
e W orinz datz and files whether 1t 15 2 DiaCx of text I your wort rd processor
_l“_ A — -
. m. - I crey Bpo : PE—— B - - r .
or 2 foiGer vour hard cnive, ransier sometiing Comps tetely from one
[ 8.1 s LU aTa -
- & —— vy 2o A 2o szcond # -
™ 1 o '.:...——ﬂ..__:‘.—- ‘\j-!-: .-...——‘E eae -'_"C:'uq“.{-fm I 3 a8 e I'Z._“ udc CrJr-t " i
,._._."_. xO
i =
F = ] Lyt e o frlbee o7 ,...
= wn the ongmal locGabon (opying & ile, [oideT ece of text
| Xt - el = i P 2
_ b Sel— = - & r =
- 3. - b - PE— P g e -
means qup L_z":.:: it It zppears o ifts new locztion and rc::.ams mn the
4 g -

1.4 —
OMC O 00.

(6) See Q. 3HOrj(E), 2014
Or

(a) What is the difference bebween ‘Ropiace
Replace’ operation in MS-Word?

(b) Explzin any three logical functicns used in \IS-E.xceL" 5

Ans. (a) Replace and Replace All in MS “ord. Find A

U w.uuuq.--—ul "E‘ laces 2 word or D‘.._.‘:._:v‘ witn "ﬂatfrt'.’.', For

d Replace operation
example, a user can

replace ¢/w with Software. The replacement text uses the same capstahzanon as
the text that 1‘ replaces unless user selects the Match case checlk box

-yoﬂ_.—-

Rechuz opton replaces one occurrence of the text at 2 tume whereas Replace
All opton re'*la:e:_ all the ooturrences of the text simultaneously.
r

(b) Logical functions in MS Excel See Q. r:-’g,, 2014

Q. 4. (a) How can vou insert audio clip in 2 PowerPoint presentation?

(b) Explain the font as formatting features in MS-Excel.

[Page S6

5
5

Ans. (a) Steps to insert audio clip in PowerPoint Presentation:

1. Click the shde to add an audio dip.
2 On the Insert t2b, in the Media group, click Audio.

3. Click Audio from File, locate the fo.ce' that contains the file, and then

double-click the file that is to be added.
(b) Formatting Font in MS Excel
To change the font or fant size in a worksheet:

1. Select the cell. range of cells, text or characters to format.

2. On the Home tab, 1n the Font group:

(1) Click the reguired font in the Font box to change the font.

(i) To change the font size. click the required font size in the Font Size box,
or click Increase Font Size Button image or Decrease Font Size Button
image untl the desired font size 1s displaved in the Font Size box.

Or

(a) How animation is useful in the context of slide show? 5
(b) What functions are used for regression analysis? [llustrate with syatax. 3
Ans. (a) Usefulness of animation in slide show. Anumation can help ‘make a
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iyt P{m,‘:rlj.q.im presentation more dynamic, and help make information
MOKE ".“-'"‘.’?""b“f- I'he most common types of animation effects include entrances
JFIIJ :ﬂ”(i' the user can also add sound to increase the intensity of the animation
eflecls. /

M:_ln‘v prf--ﬂ_—-lnlalion experts recommend using animations and sound effects
sparingly. Animation can be usefy] in making a presentation more lively, and
help 1o emphasize points, bul too much animation can be distracting.

(b) Functions used for regression analysis:

Ef’c‘i‘.}. lnClu:Jes scveral array functions for performing linear regression—
L”\'I}SI' TREND, FORECAST, SLOPE and STEYX, and exponential regression—
LOGEST and GROWTH.

SLOPE. The SLOPE function returns the slope of the linear reéression Jline. The
slope is defined as the vertical distance divided by the horizontal distance
between any two points on the regression line. The SLOPE function takes the
form =SLOPE(Fnown_y's, known_x's).

'TREND. TREND function finds points that lie along the regression line for
g d,a"'" The numbers returned by TREND function can be used to plot a
trend line, TREND function can be used to extrapolate, or make intelligent
guesees '3’??”{' future data based on the tendencies exhibited by known data.
gyntax of TREND function =TREN D(known_y's, known_x's, new_x's, const).

) PART B
Q. 5. Give éxample of any three mathematical functions with syntax. 5
Ans. Mathematical Functions:

(7) SUM. Sum function totals a series of numbers and takes the form
=SUM(num1,num2, ...), where nums (max 30) can be numbers,
formulas, ranges, or cell references. It ignores arguments that refer to
text values, logical values or blank cells.

(i7) SUMIF. Sumif function tests each cell in a range before adding it to the

total. It takes the form =SUMIF(range, criteria, sum_range), where range

is the range to test; criteria is the logical test to be performed on each cell;
and sum_range specifies the cells to be summed up.

(iif) COUNTIF. Countif function counts only those cells that match the
specified criteria and it takes the form =COUNTIF(range, criteria),
where range is the range to be tested and criferia is the logical test to be

performed on each cell. N
Q. 6. (a) Write syntax of different formula to find Maximum, Minimum, and
5

Sum of given numbers. .
(h) A person takes the loan on following terms:

* [Loan amount %35,00,000

+ Rale of Interest 19.25% p.a | -

e Loan period 4 years (48 instalments, i.e.,
P Mode of payment-Monthly)

i ] iate formula in
i heet in MS-EXCEL. Also write appropriate
il l'eqlﬂﬂ?d . EM] and interest amount for the 45" instalment.10

MS-EXCEL to compute the

Ans. (a) Syntax
(i) Maximum: =Max(num1,num2, ...)

il
i
il

I
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P N Lirmumy = Nonmuambnum?2, ()

Sum =SUM(num Lnum2, ()
(&} Excel Sheet:

Wi, |

e BN . ? B G
t . Lloanm Amounmt | 33,00,000.00

2 | Rate ! 19.25% p.a.
R ' Loan Period ] 4 years
3 ——- Mede 'ﬁ Monthly d

Formula:
(1) EMI =PMT(19.25% /12.4712,-3500000)
(i) Imterest =IPMT(19.25%/12,45,4*12,-3500000)
Or
(2) How can yvou insert, delete worksheet in a work book? 5
(3 10 kmown X values are shown in cells A2 TO All and corresponding
koows Y values are shown in cells B2 TO B11. Write syntax to find slope in
cell D2 and intercept in cell D3. Write the appropriate formula to compute
estimated v values in cell C2 TO C11. 11
Ars. (2) Insert and delete a worksheet. By default, Microsoft Office Excel
rovides three worksheets in a workbook to insert additional worksheets (and
ather tvpes of sheets, such as a chart sheet, macro sheet, or dialog sheet) or delete
dnerm as needed. To insert a new worksheet at the end of the existing worksheets,
click the Insert Worksheet tab at the bottom of the screen. To insert a new
worksheet in front of an existing worksheet, select that worksheet and then, on
the Home tab. in the Cells group, click Insert, and then click Insert Sheet. Also
Mo user can right-click the tab of an existing worksheet, and then click Insert. On
o Comeral tab, click Worksheet, and then click OK. To delete one or more
worksheets, select the worksheet or worksheets that are to be deleted, then on thL
Home tab. in the Cells group, click the arrow next to Delete,'and then ctlluf
Delete Sheet. Also the user can tht—click the sheet tab of a worksht!?_etko;) E\lSt(\}tt
bzb of any selected worksheets that is/are to be deleted, and then click Delete.
(@ Type i D:-—-SLOPEtB?JB'l;«;A;f:l;l -
. i D3=INTERCEPT(B2:B11.A=S
Iype ‘m EL ENTFR} E;l‘v- L"' 1nd copy the formula from cell C3 to cell C11.
Eype I O b nandi lpf ctions available in MS-EXCEL. 5
Q. 7. (@) Explain uses of two financial tun

(#) Payroll sheet for X LTD is prepared in MS-EXCEL as below:
K - ——— T

r'"}

A s 3 & D & ; = -
: = TA Gross
F >ory | Basic Grade DA HRA ™
1 Employee } Category [".1: Pay H_E.]rmn;_,:s
- : — B 9,000 == 4
S | A 15,000 A—

4 Sunal i 1 T ——
e S r~ 7.000 "
I

6 Total l
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IT & W% of Basic P
’ h
loniate the DA @ 33% cfEa..h:Pa' when Pay is less than 78000 and

"_ I--— —f-e—-

virde *":t \;:'rm;na:z Functions and Formulas in Cells D2 to HZ:

s "’-

—

-
-—

= TR TLAC 7L and 73300 for Emplovees Category A, B and C
rEsDwctry el
(=] HEA & 25% of Basic+Geade Pay with Maximum of ¥5,000. &
Ams. &) Fmascial Ft:ncrums-
&) PMT. [t computes the periodic payment rex Ed ol e

requ
2 specited m=mber of :‘E'.."'ZCCE and tzkes the form =PMT(rate, nper, pv,
rest rate; nper is the term (periods) of the
= VesStTent pr IS s-\E_ — cectment r—a e LQC av: "‘_ s ti"e mvestment \'a[UQ

-

€ e end of the :r:--“-{'_- if omitted); and tupe indicates when pavments
= made (1 or omitted= at end of penied; 1 = at beginning of period). {f©*
w2 caluz: myer Nusber of pericds: po Present value).

(55 PPMT. I+ o ompa ;a_:_ the principal component of an individual pavment

made v FEP2Y 2 loan over 2 specified time period with constant periodic

- -—o
p L

i

"---- - .

I 2TC 2 comstznt interest rate, and takes the form =PPMT(rate,
P‘!ﬁ*"‘: fP=T. pv, fv, type), where rat is the interest rate: pertod is the
S ber of an indiv idual periodic payment; nper is the term (periods) of
' - FT 15 the investment value toda*. £ is the investment
of the term; anc tupe indicates when payments are made
17 or cmised = 2t end of period. 1 = at beginning of period).

2307, Grade Pay. Type m Cell D2=50%°C2 press enter.

Copy and paste thefofmula i the D column,
(=) DA Type m Cell E2=[{{C2<00035%°B2.27% B2) press Enter.
Copy and past thé forfmula in the E column.
(=), TA- Type s Cell G2=1(B2=" A" .1300,1£1(B2="B",2500,3500) press Enter.
Cr,'_: ‘@nd paste the formyula in the G column.
(=), HRA. Type in Cell F2=min(3000,25% 2"(C2+D2) press Enter.
Copy and paste the formula in the F column.

Or
(z) What are the functions used to estimate the future trend from given
Talmey? 5

!&,.SbawasinaMS—HCELshcet
3 random numbers in range Al:15. Show syntax for calculating Maximum,
Minizmam, Sum, Count, Average, Mode and Standard Deviation in cells C7 to
Clis. 10
Azs. (@) Trend Function s used to estimate the future trend from given values.
The TYEND Function returns values along a linear trend. It fits a strasght line
Sy the rrethod of least squares) to the arrays known_y’s and known_x's and
22, 'r’f the v-values 2l long that line for the arra) of s pt:mflm.l new _x's. It takes the
form ‘TRE"-D:nm.:': Vs, known_x's, new_x's, const). Knoun _Y%'s 15 the set of Ye
Has that are already known in the relatonship y = mx + b.
'."..._, argusnert can be 2 single column, 2 single row, or a rectangular range of
"8 Froem_x's s an optional set of x-values that you may already know in the

’@Xt,ﬁ" v Emmy e [r
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The third and fourth arguments are optional. New_x’s are new x-values foy
which vou want TREND to return corresponding y-values.

Const is a logical value specifying whether to force the constant b to equal 0, [f
Const is TRUE or omitted, b is calculated normally. If Const is FALSE, b is et
equal to 0 (zero), and the m-values are adjusted so that y = mx.

(b) (i) To generate 50 Random numbers, type in Al=rand() and copy it from A1
to J5.

(ii) Maximum: Type in C7=max(A1:]5)
(iti) Sum: Type in C8=sum(A1:J5)
(fv) Minimum: Type in C9=min(A1:J5)
(v) Count: Type in C10=count(A1:J5)
(vi) Average: Type in Cl1=average(Al:]5)
(vii) Mode: Type in C12=mode(AL]5)
(viii) Standard deviation: Type in C13=stdev(A1:]5)

Q) ©,
0’0 °* O'

) COR)
d 0’0 %
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